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1 Important Comments
To ensure fast installation and start-up of the units described in this manual,
we strongly recommend that the following information and explanations are
carefully read and abided by.

1.1 Legal Principles

1.1.1 Copyright

This manual is copyrighted, together with all figures and illustrations con-
tained therein. Any use of this manual which infringes the copyright provi-
sions stipulated herein, is not permitted. Reproduction, translation and elec-
tronic and photo-technical archiving and amendments require the written con-
sent of WAGO Kontakttechnik GmbH. Non-observance will entail the right of
claims for damages.

WAGO Kontakttechnik GmbH reserves the right to perform modifications
allowed by technical progress. In case of grant of a patent or legal protection
of utility patents all rights are reserved by WAGO Kontakttechnik GmbH.
Products of other manufacturers are always named without referring to patent
rights. The existence of such rights can therefore not be ruled out.

1.1.2 Personnel Qualification

The use of the product detailed in this manual is exclusively geared to spe-
cialists having qualifications in PLC programming, electrical specialists or
persons instructed by electrical specialists who are also familiar with the valid
standards. WAGO Kontakttechnik GmbH declines all liability resulting from
improper action and damage to WAGO products and third party products due
to non-observance of the information contained in this manual.

1.1.3 Intended Use

For each individual application, the components supplied are to work with a
dedicated hardware and software configuration. Modifications are only per-
mitted within the framework of the possibilities documented in the manuals.
All other changes to the hardware and/or software and the non-conforming use
of the components entail the exclusion of liability on part of WAGO Kon-
takttechnik GmbH.

Please direct any requirements pertaining to a modified and/or new hardware
or software configuration directly to WAGO Kontakttechnik GmbH.
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1.2 Symbols
Danger
Always abide by this information to protect persons from injury.

Warning
Always abide by this information to prevent damage to the device.

Attention
Marginal conditions must always be observed to ensure smooth operation.

ESD (Electrostatic Discharge)
Warning of damage to the components by electrostatic discharge. Observe the
precautionary measure for handling components at risk.

Note
Routines or advice for efficient use of the device and software optimization.

More information
References on additional literature, manuals, data sheets and INTERNET
pages
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1.3 Font Conventions
Italic Names of path and files are marked italic

i.e.:          C:\programs\WAGO-IO-CHECK

Italic Menu items are marked as bold italic
i.e.:          Save

\ A backslash between two names marks a sequence of
menu items
i.e.:          File\New

END Press buttons are marked as bold with small capitals
i.e.:          ENTER

< > Keys are marked bold within angle brackets
i.e.:          <F5>

Courier Program code is printed with the font Courier.
i.e.:          END_VAR

1.4 Number Notation

Number Code Example Note
Decimal 100 normal notation

Hexadecimal 0x64 C notation

Binary '100'
'0110.0100'

Within ',
Nibble separated with dots
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1.5 Scope of Validity

Item no. Description

759-311 Modbus/TCP OPC server, single license

759-311/000-100 Modbus/TCP OPC server, 10 licenses

759-311/000-200 Modbus/TCP OPC server, 25 licenses

759-311/000-300 Modbus/TCP OPC server, unlimited licenses

1.6 Abbreviations
AI Analog Input

AO Analog Output

DI Digital Input

DO Digital Output

I/O Input/Output
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2 Modbus/TCP OPC Server
2.1 General

The OPC standard defines an open industrial interface which can be used by
PC-based software components to transfer data. The interface is based on the
OLE (Object Linking and Embedding), COM (Component Object Model), and
DCOM (Distributed COM) Windows technologies. This makes OPC an ideal
basis for the connection of industrial applications or MS-Office programs with
field devices such as the WAGO-I/O-SYSTEM in factory automation applica-
tion.

The WAGO Modbus/TCP OPC server allows easy and convenient access to
Modbus/TCP Ethernet devices. Simple configuration of the OPC server shor-
tens the time needed for training and start-up.

2.2 Technical data

759-311 WAGO OPC-Server MODBUS/TCP

OPC specifications Data Access V1.0A
Data Access V2.04

Operating systems Windows NT 4.0 (SP5 and higher)
Windows 2000
Windows 95 (with DCOM95 V1.3 und Windows Socket 2.0 Up-
date)
Windows 98 (with DCOM98 V1.3)
Windows ME

Supported protocols Modbus/TCP and Modbus via UDP

Configuration-tool included

2.3 Installation
For the operation of the WAGO OPC server Modbus/TCP the following com-
ponents must be installed depending on the used operating system on your
computer:

2.3.1 Windows 95

If the following components are not yet installed on your computer, install
these before you start the setup for the WAGO OPC server Modbus/TCP.

2.3.1.1 Distributed COM (DCOM95)

� Start the program "redist\dcom\DCOM95.exe".
� Follow the instructions of the installation program.
� Restart your computer, if requested.
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2.3.1.2 Windows Socket 2.0

Step 1:

� Ensure that Windows Sockets 1.x is installed.
� Ensure that you use the TCP/IP protocol.
� Start the program "redist\WinSock2\W95ws2setup.exe".
� Follow the instructions of the installation program.
� Restart your computer, if requested.

Step 2:

� Start the program "redist\WinSock2\y2kvdhcp.exe".
� Follow the instructions of the installation program.
� Restart your computer, if requested.

The necessary installation programs are on the CD ROM in the directory
"[LW]:\Redist". (replace [LW] by the identifier of your CD ROM drive.)

2.3.2 Windows 98

The support for Distributed COM (DCOM98) is component of Windows 98.
Microsoft Corporation provides an update to the version 1.3 in the internet.
The distribution of this update is not permitted in accordance with the license
conditions (EULA) of Microsoft Corporation. You will find the current
DCOM98 version on the Microsoft homepage at:

     http://www.microsoft.com/com/resources/downloads.asp

It is recommended to install this update in order to improve the stability of the
OPC server!

2.3.3 Windows ME

The support for Distributed COM (DCOM) is component of Windows ME.
Please install following program to configure DCOM:

     "DCOMCNFG for Windows 95 and Windows 98"

� Start the program "redist\dcom\dcm95cfg.exe".
� Follow the instructions of the installation program.
� Restart your computer, if requested.
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3 Modbus/TCP Konfigurator
3.1 Functionality

The Modbus/TCP Configurator is part of the WAGO Modbus/TCP OPC Ser-
ver delivery.

The configurator has a surface for generating or changing the OPC Server's
configuration information. This information is stored in an XML file. The only
connection between the OPC Server application and the configurator applica-
tion is this configuration file.

The OPC Server reads the configuration information from the XML file du-
ring starting.

The physical structure of the system (existing devices) and the process values
which can be reached with OPC are configured.

The configurator is structured in the same way as the Windows Explorer. The
window of the configuration application consists of two parts. The left part
contains the Modbus/TCP devices of the system in tree topology . In the right
part, the process values (tags) possible with OPC which belong to the device
currently selected in the device tree are listed.

You can reach all functions of the configurator via the main menu and its
submenus. Via the respective menus, devices and process values can be ente-
red in the configuration, deleted from it or modified. The content of the "Edit"
menu is also offered as a popup menu if you click the right mouse button.

The properties of the devices and process values can be entered or changed by
means of dialogs.
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3.2 Device Tree
The device tree consists of a network object as the root and the corresponding
devices represented in terraced form. It contains all devices to be addressed
via the Modbus/TCP OPC Server.

The network object has no parameters and is automatically generated with the
menu command "File - New". The name of the network object is "network" by
default and cannot be changed.

A Modbus/TCP device corresponds to a WAGO Modbus/TCP Coupler (750-
342 or 750-842). The parameters of a device are accessed via a dialog which is
called either by double-clicking on the device or by the Context menu "Pro-
perties". If you have selected the device, pressing the Return key will also start
the Device dialog.

The devices are organized according to their device names. The individual de-
vices with the corresponding process values in the tree structure can be copied
or deleted. If new devices are added with "Edit - Insert Device", device names
are assigned automatically. These names must be unique within the network.

3.3 List of Values
The process values of a selected Modbus/TCP device possible with OPC are
represented in the list of values. Each row in the list stands for a process value
which can be reached with OPC.

In the list of values, the value name, the Modbus/TCP address, the data type
and a description of the value are shown. The values belong to the device se-
lected in the device tree. They are listed with their names in ascending alpha-
betical order.

Value names must be unique per device.
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Entries in the list of values can be added manually, copied or deleted.

By a double-click or via the context menu "Properties", the Value Dialog is
displayed. Fast editing of names directly in the list is possible as well.

Organizing the list according to selected columns (in alphabetically ascending
or descending order) is supported. Individual columns can also be moved.

3.4 The Menu Bar

3.4.1 The File Menu

3.4.1.1 New

With the command "New", a new configuration is created. All existing confi-
guration data will be deleted.

3.4.1.2 Open

By selecting this command, you will open a mask by means of which you can
select and load existing configuration files. The configuration files are stored
with the file extension .xml.

3.4.1.3 Save

By selecting this command, you can save changes in the configuration file.

3.4.1.4 Save as...

If you select this command, you can save a new configuration or an existing
configuration with a new name. The default file extension is .xml.

3.4.1.5 Set OPC Configuration

If you select this command, you can define the actual loaded file as the OPC
configuration file.
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3.4.1.6 Quit

By selecting this command, you will quit the Modbus/TCP Configurator. If
you have performed changes in the file which have not been saved yet, the sy-
stem will ask you whether you want to save them.

3.4.2 The Edit Menu

3.4.2.1 Cut

If you select this command, you will delete the selected part of the configura-
tion (device or process value) and store it in the clipboard.

3.4.2.2 Copy

By choosing this command, you will copy the selected part of the configurati-
on to the clipboard.

3.4.2.3 Paste

By choosing this command, you will transfer the copied part of the configura-
tion from the clipboard to the selected position.

3.4.2.4 Insert Device

If this command is selected, a new device is added to the network. The Device
dialog is automatically started with the default data of the new device. Adding
the device is not possible if the network object has not been selected.

3.4.2.5 Insert Value

If this command is selected, a new value is added for the device chosen in the
device tree and the Value dialog for this value is opened. This menu item is
only available if a device has been selected.

3.4.2.6 Delete

By selecting this command, the selected part of the configuration (a device
with all process values or an individual process value) will be deleted.
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3.4.2.7 Properties

If this command is selected, the properties of a selected configuration part will
be displayed.

3.4.3 The View Menu

3.4.3.1 Toolbar

If you select this command, the toolbar of the configurator will be displayed.

3.4.3.2 Status Bar

If you select this command, the status bar of the configurator will be dis-
played.

3.4.3.3 Split

A selection of this command enables you to change the arrangement of the
configurator window areas by means of the keyboard.

3.4.4 The Options Menu

3.4.4.1 Language

If you select this command, a submenu is displayed in which you can switch
between the different languages for the Modbus/TCP Configurator (German
and English).

Please note that this switchover only becomes effective after a configurator re-
start.

3.4.5 The Help Menu

3.4.5.1 Contents

If you select this command, the online help of the Modbus/TCP Configurator
is started.
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3.4.5.2 Info

By selecting this command, the manufacturer information about the Mod-
bus/TCP Configurator is displayed.

3.5 Input-Dialogs

3.5.1 Device Dialog

If an entry is highlighted in the device tree and the Properties menu is selected,
Return is pressed or the entry is double-clicked, the modal Device dialog is
opened.

The dialog consists of 2 pages: "General" and "Extended".

The "General" page contains the following properties:
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The "Advanced" page contains the following properties:

3.5.1.1 Readable Name of the Device

The name must be unique among the devices. If a new device is generated, a
unique default name is determined automatically.
The default name is composed as follows: <serial number>_device.

Since the characters '/' and '#' are used in the namespace of the OPC Servers,
they may not be used in the device name.

3.5.1.2 IP Address or DNS Device Name

The IP address or a DNS name of the Modbus/TCP device must be indicated
in any case.

3.5.1.3 Protocol Type

The protocols TCP and UDP are supported.

3.5.1.4 Port Address

The port number by which the OPC Server accesses the Modbus/TCP device.

Default: 502

3.5.1.5 Description

Description of the device
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3.5.1.6 Minimum Scan Rate in Milliseconds

The minimum scan rate defines the time interval for the duration of which a
value is regarded as current by the OPC Server. If there is a read request for a
value within this interval, the value is not read by the device. The value within
the cache of the OPC Server is supplied to the OPC Client as the current value.

With this parameter, the load on the Modbus/TCP devices and on the Ethernet
can be controlled. The higher this value, the lower the load.

The default setting is 50 milliseconds.

3.5.1.7 Request Timeout in Milliseconds

The request timeout is the maximum time permitted for a complete I/O opera-
tion (transmission of the request + reception of the response) with the device.
If an I/O operation takes longer than the request timeout, it is aborted after the
timeout.

Default setting is 10 seconds. This ensures that the OPC Server waits at most
10 seconds till the I/O operation is finished.

3.5.1.8 Connect Retry Period in Milliseconds

The connect retry period determines the time period within the attempt of
establishing a connection with the device is repeated. The IP connection with a
device is established when the OPC Server is started. If this attempt is not suc-
cessful, the OPC Server tries to establish a connection cyclically after the con-
nect retry period is over.

The default setting contains no information. Thus, the OPC Server uses a con-
nect retry period of 3 minutes.

3.5.1.9 Unneccesary Data Read in Percent

The maximum ammount of unneccesary read data within one read operation.
This number defines the percentage of unneccesary data within the total read
data.

The default setting is 100 percent. The OPC Server creates a Modbus/TCP te-
legramm for each Modbus/TCP I/O area (DI, DO, AI, AO). With one telegram
a maximum area of 125 addresses could be read.

3.5.1.10 WAGO Output Calculation

The output addresses of tag, will be adapted to the output address area of
WAGO couplers (over 0x200). To an output address less than 0x200 the con-
figurator adds 0x200.
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3.5.2 Value Dialog

If an entry is selected in the list of values and the Properties menu is selected
or the entry is double-clicked, the modal Process Value dialog is opened.

The following properties are configured for a value:

In a separate area of the Process Value dialog, you will find the following
buttons: Next, Previous, New and Clone.

By means of these buttons, the list of values can be walked through when the
dialog is open. Changes of a value's parameters are performed by clicking the-
se buttons. When the Cancel button of the dialog is clicked, only the alteration
process for the value currently displayed in the dialog is aborted.

3.5.2.1 Name of the Process Value

The name must be unique among the process values. If a process value is ge-
nerated, a unique default name is determined automatically. This default name
is composed as follows: <serial number>_value.

Since the characters '/' and '#' are used in the namespace of the OPC Servers,
they may not be used in the process value name.

3.5.2.2 Modbus/TCP Address

The address can be entered as a 6-digit decimal (dddddd) or a 5-digit hexade-
cimal value (0xhhhhh). The first digit of the address determines the Mod-
bus/TCP table (0, 1, 3 or 4); the other 4 or 5 digits determine the value address
starting with 1. For the exception status of a device, "ES" must be entered he-
re.
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Modbus/TCP Commands:

The Modbus/TCP table of a value is determined by the first digit of the value
address.
The table selected for a process value determines the Modbus/TCP command
by means of which the value is read or written.

Table Read Command Write Command

Output Register 4 FC 3 FC 16

Input Register 3 FC 4  

Output Coil 0 FC 1 FC 15

Input Coil 1 FC 2  

Exception Status 7 FC 7  

For the "Exception Status" table, the address is set to 0 and cannot be changed
since there is only one exception status per device.

3.5.2.3 Data Type

The following data types can be selected: Bit, Byte, Word, DWord, Char,
Short, Long and Real.

For values from the Modbus/TCP tables 0 or 1, the data type is always bit.
The exception status always has the data type byte.
The values from tables 3 and 4 have a data type which is not bit.

Заказ на сайте
www.wgspb.ru



Modbus/TCP Konfigurator   �  21
Input-Dialogs

WAGO-I/O-SYSTEM 759
Modbus/TCP OPC server

Modbus/TCP Data Types:

The following table describes mapping of the OPC data types to the Modbus
data.

Data Type OPC
Data Type

Tables Description

bit VT_BOOL Coil  

8-bit unsigned
 integer

VT_UI1 register,
exception
status

bits 7-0 of the register
 = bits 7-0 of the UI1

8-bit integer VT_I1 register bits 7-0 of the register =
 bits 7-0 of the I1

16-bit unsigned
 integer

VT_UI2 register bits 15-0 of the register
 = bits 15-0 of the UI2

16-bit integer VT_I2 register bits 15-0 of the register
 = bits 15-0 of the I2

32-bit unsigned
 integer

VT_UI4 register Bits 15-0 of the first register
 = bits 15-0 of the UI4
bits 15-0 of the second register
 = bits 31-16 of the UI4

32-bit integer VT_I4 register Bits 15-0 of the first register
 = bits 15-0 of the I4
bits 15-0 of the second register
 = bits 31-16 of the I4

32-bit real VT_R4 register 32-bit Intel floating-point number

bits 15-0 of the first register
 = bits 15-0 of the R4
bits 15-0 of the second register
 = bits 31-16 of the R4

3.5.2.4 Description of the Process Value

Description of the value.

Заказ на сайте
www.wgspb.ru



22  �  Modbus/TCP Konfigurator
Connection State

WAGO-I/O-SYSTEM 759
Modbus/TCP OPC server

3.6 Connection State
The connection state is shown in the ´Connection State´ device property with
the item ID <devicename>#50000.

The connection state returns TRUE (-1) if the connection to the OPC-Server is
established and FALSE (0) if the connection is interrupted.

The connection state can be used practically only with TCP protocol. Using
the connection state with UDP protocol returns always TRUE, since UDP
protocol has no connections.

Depending on the used client program the connection state will be detected
automatically or has to be configured manually

3.6.1 Automatic Detection of the Connection State

If the used client program detectes the ´Connection State´ device property au-
tomatically, the entry ´Connection State´ is shown in the device list.
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In this case the connection state is shown by the entry <devicename>#50000.
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3.6.2 Manual Configuration of the Connection State

If the used client program does not detect the ´Connection State´ device pro-
perty automatically, the entry ´Connection State´ has to be configured in the
device list manually. For this the entry <devicename>#50000 has to be inser-
ted in the device list.

After this the connection state is shown in the list of values by the entry <de-
vicename>#50000.
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4 Files and Registry
The Modbus/TCP OPC server consists of the following files:

File Description

MBTOPC.exe Executable of the Modbus/TCP OPC server

MBT.dll Modbus/TCP Communication-DLL

ConfigModbus.exe Configuration tool of the Modbus/TCP OPC server

ConfigModbusDEU.dll Language dependent components of the configuration tool
in German

ConfigModbusE.chm English online help for the configuration tool

ConfigModbusD.chm German online help for the configuration tool

OPCENUM.exe OPC Server Enumerator

OPCCOMN_PS.dll OPC Common Interfaces Proxy

OPCPROXY.dll OPC Data Access Interfaces Proxy

The files MBTOPC.exe, MBT.dll, ConfigModbus.exe, ConfigModbus-
DEU.dll, ConfigModbusE.chm and ConfigModbusD.chm are copied by the
installation program into the installation directory of the Modbus/TCP OPC
server.

The files OPCENUM.exe OPCCOMN_PS.dll and OPCPROXY.dll are instal-
led into the Windows system directory.

During the installation the general OPC files and the Modbus/TCP OPC server
are registered.

4.1 Names and IDs
The WAGO Modbus/TCP OPC Server uses the following names and identi-
fiers

OPC DA Server Name WAGO OPC-Server Modbus/TCP

OPC DA CLSID {B3CC7FC9-AE9D-4555-BDDB-13B178EE3B69}

OPC DA ProgID WAGO.OPCServer.ModbusTCP.DA

Vendor Information WAGO Kontakttechnik GmbH

Version 1.0.<Build number>

4.2 Registry entries
The configuration information is submitted to the Modbus/TCP OPC server by
the Registry.

The settings for the server are stored under the following Registry path:
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     HKLM/Software/WAGO/OPC Server ModbusTCP

The following table shows the possible entries in the Registry.

Value Type Description

ConfigFile String Path of the configuration file

TraceError DWORD Trace settings for Error Level

TraceInfo DWORD Trace settings for Info Level

TraceFile String Path of the trace file

TraceFileSize DWORD Maximum size of the trace file

OptimizeFlags DWORD Setting of optimizing
(default: total optimizing)

OptimizeArraySize DWORD Size of the optimization array (minimum 2,
maximum 125; default 125)

MaxConnectThreads DWORD Maximum number of connection threads (mi-
nimum 1; maximum 20; default: 5)

4.2.1 Configuration

The entry with the path of the configuration file to be used is carried out by the
configuration tool (menu file -- set OPC Configuration).

4.2.2 Trace

The Modbus/TCP OPC server supports writing traces into a tracefile.

The trace mechanism has 2 trace levels: fault and information.

For each level the user can select the trace groups to be written to the file.The
following table describes the trace groups of the Modbus/TCP OPC server.

Trace group Description

0x00000001 OPC calls from the OPC clients to the OPC interfaces of the server

0x00000002 OPC notifications from the server to the OPC clients

0x10000000 Initialization/termination of the Modbus/TCP communication

0x20000000 Modbus/TCP commands from the OPC server to the devices

0x40000000 Modbus/TCP answers from the devices to the OPC server

The fault traces are set by default of the OPC server, the information traces are
not set.
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4.2.3 Optimization

The optimization flags permit to turn off certain parts of the optimization by
configuration.

Flag Description

0x00000001 If this flag is set, the Scanrate optimization is switched on

0x00000002 If this flag is set, the Read optimization is switched on

0x00000004 If this flag is set, the Write optimization is switched on

The optimization of the read commands uses an array. The size of this array
determines the maximum number of the Modbus/TCP addresses read in one
call. The size also determines the maximum time which the OPC server can
use for the optimization of the read commands (the bigger, the longer).

The percent number of unnecessarily read data determines the efficiency of
the read optimization.

4.2.4 Threads

The number of connection establishment threads determines how many con-
nection establishments can be attempted at the same time.
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5 System requirements
5.1 Operating system

The OPC server supports the operating systems Windows NT 4.0 (starting
from SP5), Windows 2000, Windows 95, Windows 98 and Windows ME.

5.2 DCOM
With Windows 95 systems the DCOM support must be installed subsequently
(DCOM95 V1.3). The necessary file "DCOM95.exe" is on the CD ROM in
the directory "[LW]:\Redist\Dcom".

For Windows 98 system the installation of DCOM98 V1.3 is recommended,
since this version runs more stably than the DCOM version, which is supplied
with the system. You will find the current DCOM version on the Microsoft
homepage at:
     "htpp://www.microsoft.com/com/resources/downloads.asp".

For Windows 95, Windows 98 and Windows ME systems the DCOM configu-
ration tool DCOMCNFG must be installed. The necessary file "dcm95cfg.exe"
is on the CD ROM in the directory "[LW]:\Redist\Dcom".

5.3 Windows Socket V2.0
The Modbus/TCP communication DLL uses the Windows Socket V2.0 inter-
face. This is not contained in the installation of Windows 95 and must be in-
stalled additionally. The necessary files "W95ws2setup.exe" and
"y2kvdhcp.exe" are on the CD ROM in the directory
"[LW]:\Redist\WinSock2".

5.4 MSXML
The configuration file contains the configuration information in XML format.
For reading and writing the XML information the DOM part of the MSXML
Parser is used (Microsoft.XMLDOM). This is installed by the Setup program
of the OPC server.
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6 DCOM Configuration
The DCOM configuration on OPC client and OPC server computers can cause
problems at the setup of OPC installations.

The DCOM configuration settings can be changed with the DCOM configura-
tion tool DCOMCNFG.

The following settings solve the most DCOM problems:

Default Authentication Level: None

Default Impersonation Level: Impersonate

It has to be guaranteed also in the DCOM configuration, that for the respective
OPC client user the access to the OPC server is permitted. This is made easier,
if client and server computer are in the same domain.

The identity the OPC servers runs with should be set to a firm account (do-
main user).

A DCOM server under Windows 9x and ME systems cannot be started by re-
mote. The OPC server should be started automatically at the system start on
these systems (if remote control desired).
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